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Digital Image Delivery System for the Imagelink Digital
Workstation

Sending Microfilm to the Next Generation!

The Digital Image Delivery System (DIDS) Version 2.0 utilizes the Eastman Kodak Imagelink Digital
Workstation (IDW) to provide true Film Based Imaging. DIDS locates the image, displays it on the PC
screen, allows enhancement and augmentation of the image and routes it to its intended user. Images
from different sources, such as the IDW, CD-ROM, network files, and a Twain-compatible scanner may
be combined into a single e-mail, fax, published on the Internet or Intranet, or print job. Check
Stacking is accomplished with a simple “rubber-banding” technique that assures absolute accuracy.
The highly intuitive interface is easy to learn and use in a production environment. Most functions may
be accomplished using either mouse controls or keyboard commands.
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Chapter One
DIDS Software Components
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DIDS Components

The Digital Image Delivery System software is made up of the following components:



IDW Scanning Control

e Current Address - Notifies the user of the film s
. IDW Scanning Control
address for the current image.

— Film Location Information

« Block, File & Page - Enter the image search . E'”f:dd Fils Page
address here. The film mode you select under arren re=s
the IDW Configuration window makes the | | | o
appropriate fields active. Search Address
» Search — Clicking Search button activates the I I I 1
IDW and advances the film to the correct image. Positioning Controls
Pressing the [Enter] key after entering the search
address activates this button. Search Preset Eject
« Preset - Sets the value specified in the Block, SRR == Load
File and Page fields as the current film address.
The beginning address of a roll may be preset L | B
before the roll is inserted in the IDW. To preset _ cearch Interval
a roll, enter the beginning address, click on  Block = File v Page
“Preset”. This will change the “Current Address”
. 1 3 l
to the preset address. Insert the roll and click on J—l !
“Load”. The IDW will now treat the roll as — Duplex Scan Exposure
beginning with the preset address. Pressing the i~ Base (" Simplex ¥ Duplex { Check
“*” key on the number keypad after entering an Front Image Exposure
address activates this button. J
¥ J b 14
« Eject - Rewinds the microfilm roll. Pressing the Rear Image Exposure
[End] key when the image view is active will ﬂ J PI 19
activate this key. [Medum =] Fim | orf ~| aec
+ Search & Scan — Activates the IDW, advances IText vI [~ Threshold Processing
the film to the correct image, scans and displays
. 1 rl 20
the image. J 1=
) —View Properties
e << - Searches backward and displays the next
image according to the value specified in the Front Rear Skew
Search Interval scrollbar.
—Automatic Functions
Ao Scan Bigtzh Scan | ||Run Register
e >>/ Load - Searches forward and displays the

next image according to the value specified in Total Scans - 481, Total Prints -8
the Search Interval scrollbar. When this button is
labeled “Load”, it loads the film and advances to
the first image. Pressing the [Home] key will
activate this button when it is in the “Load”
mode.

e Scan — Scans and displayes the current image using the current settings. This button enables
you to rubber band an image if the image-processing mode has “Base” checked below (Base,
Simplex, Duplex or Check). This button’s action depends on the position of the image-
processing mode selector. “Simplex” scans a single section. “Duplex” scans the front and back
images. “Side 1” will be displayed followed by “Side 2”. “Check” uses the IDW'’s current




settings (including Crop and Border Removal) to scan the front and back of a check and
displays the combined image.

Scan Front — Scans the front image area, displays the image and allows “rubber-banding”
selection of the front image. The selected area is combined with the existing rear image and
displayed as a combined image.

Scan Rear — Scans the rear image area, displays the image and allows “rubber-banding”
selection of the rear image. The selected area is combined with the existing front image and
displayed as a combined image.

Search Interval — Scrollbar and edit box allows you to select the number of images (as
modified by the Block, File, Page radio buttons) that you will skip ahead or backwards when
using the Batch Scan, <<, Auto Scan and >> buttons. The maximum number of images is 100.
You may type the interval into the edit box or move the scrollbar.

Section Scan Exposure / Check Scan Exposure / Duplex Scan Exposure — The controls
within this group box will affect the exposure of the listed type.

Front Image Exposure — This scrollbar sets the IDW'’s exposure for the front image.
Rear Image Exposure — This scrollbar sets the IDW’s exposure for the rear image.
Front — This button moves the IDW Scan area to Channel B.

Rear — This button moves the IDW Scan Area to Channel A.

Skew — Allows
adjustment of the e
rotation of images
after scanning. Use
this to adjust an image | 4

that has been modified 0= Jll 4
since scanning or
reprocessing, or for
fine adjustment of the
image alignment. In
check mode this 0K
option allows -
adjustment of the Cancel |
front and back images

seperately.

E

Clackwize Angle [degrees]

=

v | Resize

Auto Scan - Allows you to automatically scan images beginnign with the current image and
continuing until STOP is clicked. (Not active in this version of DIDS)

Batch Scan - Allows you to automatically scan images beginning and ending with specific
addresses. (Not active in this version of DIDS)

Run Register — When available, this button allows the user to run CAR commands previously
downloaded with the (optional) DIDS Car Emulator.

Total Scans — Displays the cumulative total of scans (does not include “Base Scans”).



e Total Prints — Displays the cumulative total of prints (or faxes).



Toolbar

The Toolbar is displayed across the top of the screen. It contains tools for annotating the image, and
distributing the image. It may be resized and located to match you screen resolution by moving the
top or bottom of the tool bar. If the text does not line up correctly check the “font” settings under the
advanced section of the Screen Properties. It is important that this be set to “Small Fonts”.
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e Save — writes the current image to disk using the current file name. This also saves all
annotations. There is no keyboard equivalent.

e Print — sends the current image (or group of images) to the default printer. The keyboard
equivalent is P or Ctrl-3.

e Fax — sends the current image (or group of images) to the fax software. The keyboard
equivalent is X.

e Send — e-mails the current image (or group of images) using the default mail program. The
keyboard equivalent is Ctrl — 2

e Publish — sends the current image (or group of images) to an Internet or Intranet location via
FTP or by saving the images directly to the Intranet location, and creates a customized e-mail
message containing the URL of the image(s). The keyboard equivalent is U.

o XXXXXXXX.mpt — Adds the current image (or group of images) to the current MPT file. If
the file does not exist, it is created. There is no keyboard equivalent.

» Select — selects the pointer tool, allowing selection of individual annotations. There is no
keyboard equivalent.

» Line - allows drawing of straight lines anywhere on the image surface, after drawing the line,
click the right mouse button to bring up a menu that allows modification of the line. The
keyboard equivalent is Ctrl-L.

« Rect(angle) - allows drawing of a rectangle anywhere on the image surface, after drawing
the rectangle, click the right mouse button to bring up a menu that allows modification of the
rectangle. The keyboard equivalent is Ctrl-T.

» Ellipse - allows drawing of an ellipse anywhere on the image surface, after drawing the ellipse,
click the right mouse button to bring up a menu that allows modification of the ellipse. The
keyboard equivalent is Ctrl-0.

e P(oly)line - allows drawing of series of lines anywhere on the image surface, after drawing
the lines, click the right mouse button to bring up a menu that allows modification of the lines.
The keyboard equivalent is Ctrl-P.



P(oly)gon - allows drawing of a many-sided object anywhere on the image surface, after
drawing the object, click the right mouse button to bring up a menu that allows modification of
the object. The keyboard equivalent is Ctrl-Y.

Arrow - allows the drawing of an arrow anywhere on the image surface, after drawing the
arrow, click the right mouse button to bring up a menu that allows modification of the arrow.
The keyboard equivalent is Ctrl-A.

Free(hand) - allows the drawing of a free form object anywhere on the image surface, after
drawing the object, click the right mouse button to bring up a menu that allows modification of
the object. The keyboard equivalent is Ctrl-F.

Hilite - allows the drawing of a translucent rectangle anywhere on the image surface, after
drawing the rectangle, click the right mouse button to bring up a menu that allows modification
of the highlighted area. The keyboard equivalent is Ctrl-H.

Redact - allows the drawing of a solid box that will cover up data anywhere on the image,
click the right mouse button to bring up a menu that allows modification of the redaction box.
The keyboard equivalent is Ctrl-1.

Text - allows the insertion of text anywhere on the image surface. Selecting TEXT activates a
dialog box that allows entry of the textual information. After drawing a rectangle, click the right
mouse button to bring up a menu that allows modification of the text. The keyboard
equivalent is Ctrl-X.

Note - allows the drawing of a post-it type note anywhere on the image surface. Selecting
NOTE activates a dialog box that allows entry of the textual information. After drawing a
rectangle, click the right mouse button to bring up a menu that allows modification of the text.
The keyboard equivalent is Ctrl-N.

Logo - allows the addition of another image anywhere on the image surface, after drawing the
object, click the right mouse button to bring up a menu that allows modification of the object,
the default image is set in the Configuration option on the File menu. The keyboard equivalent
is Ctrl-O.

Stamp — allows the drawing of a pre-defined “Rubber Stamp” on the image. (Please note that
rubber stamp images are not saved when using “Wang mode” for saving annotations. There is
no keyboard equivalent.

Magnify - allows for selection of the magnify mode. The keyboard equivalent is Ctrl-G.



The Main Menu

¢ Open File - allows the opening of an image that
was previously scanned or stored on a local

File Edt “iew Image HReprocess Options Tw ’ . . .

= : : drive, CD-ROM or network. Selecting this option
Lz=h P leat displays a standard Windows file selection
Open Folder... i ; screen with long file name support. Opening a
Browse Folder ublish  Test.mpt file resets the default folder for saving scanned
Browse MPT File. images to the folder selected.
Save... * Open Folder — allows the opening of a folder

Single Image and displaying the images one at a time. The

images displayed may be annotated.

Frofile k Multiple Image
Frinter Setup * Browse Folder — allows the opening of a folder
Frint and displaying the images in thumbnail view.
Fax
Ea;t Print e Save - saves the displayed image under the default name.
Send » Save As - allows the displayed image to be saved under a new
Publizh name, the image may be saved as an individual TIFF image, a

. CMP image (equivalent to using maximum compression and can
Exit only be read by DIDS), a Windows Bitmap image, a Portable

Network Graphic (PNG) image (can be read by most browsers), a

PCX image, a JPG image or a Multi-Page TIFF image (with an .mpt
extension). Long File Names are supported for both folder and image names. Saving a file
resets the default folder for saving scanned images to the folder selected. When an existing
MPT file name is selected a prompt is displayed to allow adding images to the existing file or

deleting the existing file first. Digital Image Delivery System |

* Profile - Save - saves all MSIZ107. mpt haz 1 pages. Do vou want to add new pages to this file 7
settings, including window size, To retain the exizting pages and add new pages, select es.

printing options, scanning To delete the existing pages and start & new file, zelect Ma.
. . Select Cancel to returk to image view.

options, search options, paths,

etc. in the current profile. Profile

— Save As - saves all settings,

including window size, printing

options, scanning options, search options, paths, etc. in a user named file with an .MSI

extension. Long File Names are supported so a profile may have a descriptive name such as

“IBM 3890 film” or “Lundy Film”, etc..

Mo Cancel

» Profile - Load - loads a previously saved profile, including window size, printing options,
scanning options, search options, paths, etc. from a user named file with an .MSI extension.
Long File Names are supported so a profile may have a descriptive name such as “IBM 3890
film” or “Lundy Film”, etc..

« Profile - Defaults — loads a default profile. This is useful for correcting startup problems.
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Printer Setup - runs the control panel printer setup panel. DIDS prints to the Default Printer
using the settings selected in this panel.

Print - prints the displayed image to any Windows printer or fax. A standard Windows Select
Printer dialog is displayed to allow selection of the printer or fax and to set printer options.

Fax - faxes the displayed image to any Windows fax.

Fast Print - prints the displayed image to the default printer. The keyboard equivalent is Ctrl-

3orP.

Send - automatically runs the

default MAPI mail program, creates i Untitled - Message [HTML) -0 x|
a new message and inserts the J File Edit Yiew Insert Format Tools Actions Help

image. The keyboard equivalent is — - : »
Ctrl-2. Jsiend == | 1] > J Arial -

Publish - Sends the image
to an Internet or Intranet
location. The image is sent
as a JPEG image and may be
viewed in a Web Browser.
This option also creates an
e-mail message containing
the URL of the image. The
e-mail message is created
using a template.

0 Send — Click this
button to initiate the
ftp transfer or file
save.

o Cancel — Click this
to cancel the ftp
transfer.

|ﬂ This message has not been sent,

To... ||
e ||

Subiject: I

PSI2345.tif

Publizh on the Internet |

FTP Server Idertification: Cancel |

Iftp.server.cum

Publizh image to folder:

Ia"imagesx'
Wwieb addrezs of image

Ihttp: Afvanan company. comdimages

IJzer Mame: |L| zerM ame

Password; |>==<=<==>==<xx ¥ Save Pazzword

E-Mail Template IE:HPngram Fileshimsdidshrequest. tpl
Quality % Best [large image] © Eetter [medium image] ¢ Good [zmall image)

[ DoMotShow This Again & FlSize  1/25ize ¢ 143 Size




o FTP Server Identification — Enter the name of the ftp server.
o Publish image to folder — enter the full path of the destination folder on the server.

0 Web address of image — Enter the URL of the destination folder. If the URL begins
File:// DIDS will send the image to a local folder (in this case the “Publish image to
folder” space must contain a fully qualified local or network path).

0 User Name — Enter the user login name for the ftp server.

o Password — Enter the login password for the ftp server.

0 Save Password — If this is clicked the password will be saved in the INI file, please
note that the saved password is not encrypted.

0o E-Mail Template — Contains the name of an HTML file containing the template for the
E-Mail Message. The template can contain any valid HTML but must include a line that
reads:

<INSERT LINK>

B Undtithesd - Mezrage [HTML)
Fle £ ew Jrest Fpmat Jook fActions bk
Hged- H S A T | e - =|ale £ oo ; e

a P

D This message hias not been sent,

To,- I [l
|

Subject: |

Please click on the following to view your image:

Fddbp o £ Rale o e/ METET4

This image was produced using Micrographic Sciences' Digital Image Delivery
Syslem,

The original microfilm was scanned using a Kodak Intelligent Microimage Scanner.

To learn more about this technology visit our web page www. micrographicscience.com
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o Do Not Show This Again — If this is checked, this window will not display and DIDS
will use the saved information.

o Full Size /7 2 Size / 1/3 size — DIDS will resize the image before sending it to the
destination folder.

Exit — Refiles the film and closes DIDS.

13



EDIT

'u" Digital Image Delivery

Tool - displays a

menu that allows the
selection of a tool.

This function is
identical to the
Annotation Tool Bar.
Selecting Rubber Stamp

OEprocess  Uplions 1 wain

displays a submenu that L —
i Fainter
allows selection of the v AutaSave Annotations Fon
current Rubber Stamp 4 leaWiann Armotatinns nectangle
message. i i Eedact
Taut
. I —
Insert Message - Inserts a message into the ——FubberStamp—

System - C:\Program Files\Intelligent Microimage Scd

image. The keyboard equivalents are F1 through F5.
After insertion the message may be moved, resized or the font options
may be changed. To change the text or font options click on the right
mouse button.

Copy - allows the copying of the entire image or a section of the image
to the Windows clipboard. This allows easy communication with other
applications. If Section is selected the mouse is used to define an area
to be captured by holding down the left mouse button and dragging the
mouse over the desired area. When the button is released the
highlighted area is captured to the Windows clipboard.

Paste - allows the pasting of information or image data from the
Windows clipboard. DIDS or another application may have previously
captured image data to the clipboard. When pasting image data DIDS
allows it to be resized before adding to the existing image. A dialog
box is displayed that allow selection of the percent of increase or
decrease in size. After the image is placed it may be moved or
manually resized with the mouse. There are three options for pasting
the data.

o As a New Image - a new image is created containing only the
data from the clipboard.

o Into this Image - the clipboard data is pasted into the current
image. It may be moved and resized manually with the mouse.

AEHghed
Checked
Client Attorney Frivilige
Copy
Diraft
Extended
Fax
| mpartant
|Fveoice
Matice
Dfficial
O File
Paid
Fazzed
Fending
Frocessed
Received
Fejected
Releaze
Sent
Shipped
Top Secret
Irgent
Wioid

0 As a New Page - A new blank image is created (8.5 x 11 inches) and the clipboard
data is pasted into the new image. It may be moved and resized manually with the

mouse.

Auto Save Annotations - allows selection of auto save mode.
saves changes to the image before printing, faxing or mailing.

In auto save mode DIDS

Use Wang Annotations — causes DIDS to save annotations in the TIFF header, compatible
with the Wang viewer included with Windows. The Rubber Stamp messages are not saved in

this mode. (This is not available in this version of DIDS)

14



VIEW

* Normal - displays the image at a 1:1 ratio.

e Zoom - allows display of the image at a variable ratio,
from 1% to 500%.

Digital Image Delivery System - C:A\Prog
File  Edit | Yiew Image Reprocess  Options

* Fit Image to Window - is the default display mode, Narmal y
the entire image is shown on the screen. This mode is E@ F oo, 7
used for all scan area selections. eweaeel . Fit |mage ToWindow
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IMAGE

The M key displays a tool bar that contains many of the functions of the /MAGE sub-menu.

» Despeckle - removes “noise” from the image or a selected region in the image. When
selected DIDS prompts for the percentage of noise removal, it is best to use a small percentage
and use the option multiple times. If too much of the image or region is removed use the
Revert to Saved Image or Reprocess menu option to start over. The keyboard equivalent is
Ctrl-D.

» DeSkew - straightens the image. The keyboard equivalent is Ctrl-K.

» Brighten - lightens or darkens the image by a user-selected percentage. This is most
effective with 256 Gray Images (if the image is BiTonal, DIDS will convert it to grayscale). The
keyboard equivalent is Ctrl-B. (Because the IDW produces BiTonal images only this option is of
limited value)

Digital Image Delivery Syztem - C:\Program Files\Intelligent Microimage Scan
File Edit “iew | |mage Heprocesz DOptiohs Twain  Help | """"" Bisspackis

= Despeckle D Dezkew
Hodi v KOz —

Save Prnt F Brighten B e Rect Elipse Pline Pgon =

§ - Egualize “E Equalize
£\ WS \im a R 7 |Freert

Contrast “C C

Sharpen e Lantrazt

Grapzcale Sharpen

Halftone grayscale

Femove Dots from Bitional Images A Halftane

Set Region R
Remove Region I

Bemove Dotz

Set Beqgion

|
|
|
|
|
|
|
ikl A | |
Smooth Bittonal Images ECK CONTROL DOCUM! | Sroath
|
|
|
|
|
|
|

Rotate ;E 'jdEEI“EES Remove Region
i egrees
;et Bu:uru:lzr H;mu:uval Fegion 25 ez Border Femaval
e E B ErdEr 180 degrees Zoom Section
&utomatic Border Rermowal F9 225 degrees ruaoo Revert
270 degrees
Cloze Menu

_ Hevrt ] Savelage R o s
i ; ' ' zer Defined

e Equalize - Linearizes the number of pixels per gray level in a bitmap. This can be used to
bring out the detail in dark areas of an image or region. This is most effective with 256 Gray
Mode images. The keyboard equivalent is Ctrl-E. (Because the IDW produces BiTonal images
only this option is of limited value)

e Invert - Inverts the image or region. The keyboard equivalent is Ctrl-I.

» Contrast - Increases or decreases the contrast of an image or region. The user is prompted
for a percentage increase or decrease. This is most effective with 256 Gray Mode images (if

16



the image is BiTonal, DIDS will convert it to grayscale). The keyboard equivalent is Ctrl-C.
(Because the IDW produces BiTonal images only this option is of limited value)

Sharpen - Increases or decreases the sharpness of the image or region of the image. The
keyboard equivalent is Ctrl-S.

Grayscale - Converts the image to an 8-bit Grayscale image.

Halftone - Dithers an 8-bit image (such as a 256 Gray Mode image) to 1-bit for display and
printing. (Because the IDW produces BiTonal images only this option is of limited value)

Remove Dots from Bitonal Images — finds and removes dots, specks, and blobs of various
sizes in 1-bit (Bitonal) image. This function works only on 1-bit black and white images. If a
region is selected, only the selected region will be changed by this function. If no region is
selected, the whole image will be processed.

Smooth Bitonal Images — smooths the text in scanned text documents. This function works
only on 1-bit black and white (Bitonal) images. If a region is selected, only the selected region
will be changed by this function. If no region is selected, the whole image will be processed.

Set Region - allows selection of a rectangular region of the image. Once selected all of the
above menu options operate only on the region until Remove Region or Revert To Saved
Image is selected. The keyboard equivalent is Ctrl-R.

Remove Region - cancels regional processing and removes the region from the image.
Changes that have been made in the region are retained. The keyboard equivalent is Ctrl-M.

Rotate - allows rotation of the image in 45-degree increments or by a user-defined increment.
As the image is rotated area is added to the image to retain the entire image. The area added
is black for the 45-degree increments and white for the user defined increments. There is no
keyboard equivalent.

Set Border Removal Region — allows selection of multiple regions for border removal. All
area outside of the selected regions is cleared when Remove Border is selected or the right
mouse button is clicked.

Automatic Border Removal — removes solid border areas using a software border removal
system. The keyboard equivalent is F9.

Revert To Saved Image - reloads the image from disk without saving changes.

17



SCAN

Digital Image Delivery System - C:\Program Files\idwdids\Default.ms

File Edit View Image | Scan Options Twain Help
~_— ReScan Front

H(ﬁ_‘;;; il ; ReScan Rear

Save Frnt Fa® Sen  ReScan Baze

e O e, ReScan Section

Rescan Chedk (Front & Back) C

LN

Select Line

m 3T

« ReScan Front - Rescans just the front image of a duplex image and rebuilds the compound
image. This allows the user to change the exposure or scan options for just the front image.
The keyboard equivalent is F.

* ReScan Rear - Rescans just the rear image of a duplex image and rebuilds the compound
image. This allows the user to change the exposure or scan options for just the rear image.
The keyboard equivalent is R.

 ReScan Base - Rescans the Base Scan. The keyboard equivalent is B. (This option is not
active in this version of DIDS)

» ReScan Section - Rescans the section. This allows the user to change the exposure or scan
options without doing a new Base Scan and selecting an area. The keyboard equivalent is S.

 ReScan Check (front and back) - Rescans both areas of a duplex image allowing the user
to change the exposure or scan options without doing an new Base Scan and selecting the
areas. The keyboard equivalent is C.

18



OPTIONS

Digital Image Delivery System - C:\Program Files\idwdids\Default.msi

File Edit View Image Scan | Options Twain Help

= [ =l R k NOol=z 227 <n

Save Print  Fax Send Publ:  Print Options. .. Select Line Rect Elipse Pline Pgon &mow Free Hilite Res

R C:\DIDS\test\front\MSI89.4f

U Sy o i i T e [T T e ——— =

* IDW Settings — Displays the IDW Settings Dialog. (See IDW Configuration Window)

« Configuration - allows adjustment of the DIDS configuration. Clicking this option will display
the Configuration window.

Apphcation Confuperation x|

Image Path.  [C\DI0Sestyron: Browsa |

Humber of dews o archive scannad mages |1
Annohadan Messages - Check Image Options
Meszage 1 [F1] |I:-:ul1E'¢_».r o o hrvarscial instiubarn

Messoge 2 [F2] [':mlde-ulml

I+ Flip Back of Checks 180 dagraas

 General Opions

Message 3[F3] |Dao Nol Copy ¥ Promgt for Save Profile

Messnps 4 [F4] |EFE-5IF'D55iI:IIr. Capy (i PV S e ——

Message & [F5] |Conidantisl I~ #sklor FTF informedian

Messans Fon Siza IF ¥ Fervar Quality over Speed when loading thumbnails

COMS: =] DAY Corroliar Pos

CAR Annoistions Iﬁ Simnt Charsctar

Font Marme ||:‘:-_IREFE HEW

Font Siza |75 Fese ScanPint Countsr |
* Position | Loga Fila |n:u:|na'-nEwsl.EMp Birowse

* Posiion |E Eo T r-.'.' FiF o

Choosa

0 Save - closes the Configuration screen and saves all changes.
o Cancel - closes the Configuration screen without saving any changes.

o Image Path - displays the current folder in which images are being saved. The path may
be changed manually. A long file name or a path name containing a space may be used
by ending the path name with a slash “\”. Click the Browse button to browse a list of the
current folders available.



Number of Days to Archive Images. Each time DIDS is started all TIFF images created
by DIDS older than the number of days entered are deleted. If images are saved using the
Save As option the user is responsible for deleting them.

0 Message 1 -5 -DIDS allows 5 stock phrases for automatic insertion. They may be
edited in Message 1 through Message 5.

0 Message Font Size - Sets the font size of the Message Stamp, generally a value of 50
works well for Windows 95/98 and a value of 100 works well for Windows NT.

o CAR Annotations — Sets the font name, size, and location for annotations inserted
via a CAR command. For check images use the defaults of COURIER (or COURIER
NEW) for the Font Name, 75 for the Font Size, 3 for the X Position, and 8 for the Y
Position will work well. (Note: the X and Y positions are in inches.)

o Flip Back of Checks 180 degrees - Some film devices, such as the IBM 3890, film
the rear image of the document through an odd number of mirrors resulting in the
image being displayed rotated 180 degrees. Check the Flip Back of Checks 180
degrees box and DIDS will rotate the second selected area before combining a duplex
image.

o Prompt for Save Profile — If this is checked, DIDS will prompt the user to save the
Profile when DIDS closes, if changes have been made.

0 Ask for FTP information — causes DIDS to display a screen requesting FTP server
information when using the Publish option.

o Use film location for the file names — causes DIDS to use the film address as the
image name rather than the default system using random names.

o Favor Quality over Speed when loading thumbnails — If this is checked,
thumbnails will load with maximum quality. If this is not checked, thumbnails will load
faster but will be of poorer quality.

o IDW Controller Port — Selects the COM port connected to the IDW.

0 Start Character — The IDW start character.

0 Reset Scan/Print Counter — Pressing this button resets the print and scan counters
to 0 (Note: this action is effective immediately and is not reversible).

0 Logo File — Enter the name of the Windows Bitmap image to be inserted with the
LOGO button on the

Toolbar. Select Fax Dnver |

— Printers

0 Fax Device — Enter
the name of the fax
driver to be used for M arme; j
faxes. If you are

H -
uncertain of the name HP Lazer)et [l I
of the fax driver, enter b

“NONE” in this space.

The next time an 0k I Cancel
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attempt is made to fax an image DIDS will prompt with a selection screen listing
available drivers.

Print Options — displays the Print
Options Dialog.

. Ok
0 OK —Closes the dialog and -
saves settings. : [ Raotate Print 90 Degrees Cancel |

¥ Do not print images with coverage less than I-':'5 4

Printing and Display Options |

o Cancel — Closes the dialog
without saving changes.

0 Automatic Print — If this is :
checked DIDS will print each [V Date/Time Stamp ¥ Message Stamp I™ Fitto Page

final scan as it is displayed.

Dizplay and Print ophions

0 Rotate Print 90 Degrees —
If this is checked, DIDS will

rotate the image 90 degrees CURlE 7R CO100% O 125% & Manual |E|_|:|
before printing.

Image Frint Size [or Check Dizplay and Frint Size)

o Do not print images with
coverage less than X %6 - prevents DIDS from printing images that are apparently blank
when using automatic or batch printing.

o Date/Time Stamp - causes DIDS to incorporate the current date and time at the top of
each image each time the image is saved, printed, faxed, or e-mailed. To set the font size
of the Date/Time Stamp, adjust the “FontSize” setting in the [MSIDIDS] section of the
“IDWDIDS.INI” file, generally a value of 50 works well for Windows 95/98 and a value of
100 works well for Windows NT/2000/XP.

0 Message Stamp - causes DIDS to incorporate the contents of the Message 1 field at the
top of each image each time the image is saved, printed, faxed, or e-mailed. DIDS allows
5 stock phrases for automatic insertion. They may be edited in Message 1 through
Message 5 on the Configuration Screen.

0 Print Size - selects the relative print size Digital Image Delivery System |

of printed images, or the relative size of

check images (both on the screen and Enter a number from 5 to 20,

printed), 509, 75%, 100%, or 125% of @ The image will be sized as follows:

the original document size. Select Manual 8.5 will zize the image at 85%, 10=100%, atc..
to choose a custom size. In Manual, enter
a number from 5 to 20 as per the message
box DIDS displays. This selection is
overridden for non-check images by the Fit Image to Print Page. The Fit Image to Print
Page should always be checked for check images.
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IDW Settings

Selecting IDW Settings from the Options menu will display the IDW Configuration window. The
following is a list of options that can be modified in the IDW Configuration window.

* Mode - There are 30 different
film search modes that you can
choose. Selecting a new Search
Mode will change the other
options to the default settings
for the chosen Search Mode. A
few useful modes:

0 Mode 03 is used for 24X
film with single level A
channel image marks.

0 Mode 10 is used for 40X
film with two level A
channel image marks.

0 Mode 09 is used for IBM
3890 film.

* Address Level - You can
manually adjust your film level
(Block, Page & File) by choosing
level 1, 2, or 3. This setting
determines the availability of the
Block, File, and Page input
boxes.

* Film Format - You can choose
Simplex, Duplex or Duo-duplex
formats.

» Stop Position - You can choose what position the blip is located at on the film here. (This

IDW Settings

End Detection ISEIEI i vI
Image Offzet IEI T vI
Image Mark. INegativ vI

Addrezs Level I'I Lewvel "I

Filrn Farmat ISimpIe:-: vI
Stop Pozition ILeft "I

Set Defaultsl

— Scan Sethings

Film Polarity IN eqative

Border Erasure ILeave

Automatic Skew Correction IEIN

Led Lol L Lo

Image Rotation II:I

Image Resalution 200 dpi 400 dpi

M ade Mame |IDW1 [# Dedicated Mode

[must be in format

[0 Path C:%didsh DM ame]

IE:'&DIDS&TEST

ok |

Cancel |

option is not applicable to the IDW at this time)

» End Detection — this option is not applicable to the IDW at this time.

« Image Offset - This option helps you align the image higher or lower in the display window.

« Image Mark — Select whether the film blip is positive or negative here.

The SCAN SETTINGS tab allows adjustment of the scan parameters. These settings are used when

the image is scanned or reprocessed.

» Film Polarity - This setting determines the polarity of the resulting scan, to obtain a positive

appearing image from negative film use Negative, to obtain a positive appearing image from

positive film use Positive.
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Border Erasure - instructs the IDW to remove extraneous dark borders from the image
before passing it to the PC. Leave retains the scan area as selected, Remove removes the
border perpendicular and parallel to the edge of the document, Software removes the border
using DIDS built in algorithm (equivalent to using the F9 key).

Automatic Skew Correction - adjusts the position of the document to correct for skewing
of the documents during filming.

Image Rotation - determines the orientation of the image on the screen. The adjustments
are 0degrees, 90 degrees, 180 degrees, and 270 degrees.

Image Resolution — 200 dpiis usually best for films with reduction ratios less than 40X, 400
dpi is usually best for film with reduction ratios greater than 40X.

IDW Node Name — Enter the name of the node emulator to be used for image transfer.

Dedicated Node — Select this to use a dedicated node (recommended for highest
productivity).

IDW Path — Enter the path for image storage. Must end in the folder with the same name as
the IDW (e.g., if the IDW is named “test” and a dedicated node is used, the path would be
c:\dids\test )

A click on the OK button saves the configuration changes and returns to DIDS.
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= Diegatsl Imsge Debvery Spsiem - LWPiogram Fdes'dnbelligent Hoimspe boanmes DhmdS ma
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E S| Soumce

T,

e Select Source — allows selection of a Twain compatible scanner.

e Acquire — scans and displays an image using a Twain compatible scanner.
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HELP

jsia Digital Image Delivery System - C:\Program Files\idwdids\Default.msi
File Edit View Image Scan Options Twatheb

HALSy o Do&a.

Save Print  Fax Send Publizh Tesl ct Elipze Fline F'gn:-n_}

* Help — Displays this manual in PDF format. If the manual fails to display on a Windows
NT/2000/XP system, add the line WindowsNT=1 to the [IDW_SETUP] section of the
“IDWDIDS.INI” file.

« Download Updates — Connects to the IDW DIDS web site. (www.micrographicsciences.net)

* About — displays the DIDS version information, copyright information and allows licensing of
DIDS.
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Chapter Two
Operating the DIDS Image Delivery System
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Operating the Diqgital Image Delivery System for the IDW

In this chapter you will be given step-by-step instructions on using the Digital Image Delivery System
software. You may wish to refer to chapter one from time to time for a more detailed description of the
fields mentioned in this chapter.

To start DIDS click on the icon on the Windows Desktop. During startup DIDS will display a

splash screen identifying the version. DIDS examines the scanned images on the local hard
drive and deletes images that have passed the expiration date (see the Configuration Screen for more
information on expiration dates).

% Before starting DIDS, start the dedicated node by clicking the mini-node icon on the desktop.
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21 x|
Look in: IE}idwdids j - £F B~

Ibm3890 deposit reconstruction.msi
Ibm3890.msi

landscape . msi

[undy.msi

manual.msi

ii=F portrait.msi

File name: [Zlefaurt.msi

- Open |

Flescftype:  [Profil Fies ("msi) =l Cancel

7

The Load Profile dialog is displayed. Choose the correct profile and click on Open. If Cancel is clicked,
all settings will be set to the defaults.

Once the Scanning control is updated and displayed the system is ready for operation.

The typical workflow for a check retrieval operation is to enter the beginning address of the film and
either click on the Preset button or the “*” key to preset the address.

Enter the address of the required image and either hit the Enter key or click on the Search button.

The film will advance to the image selected. Clicking on the Scan button will scan the image and
display it on the screen. The “Search & Scan” button provides both of these functions.

In check mode DIDS will display the front and back of the check on the screen. At this point you may
make adjustments and click on Scan Front, Scan Rear or Scan to make changes to either the front, the
back image or both. To make changes to only the front, make the adjustments then click on the F key
or the Scan Front button; only the front image will be changed. To make changes to only the back,
make the adjustments then click on the R key or the Scan Rear button; only the back image will be
changed.
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Scanning Check Film Images

To scan check images please use the following steps:

1.

Click on the Check radio button, located in the lower
half of the IDW Scanning Control window.

Enter the search address in the Block, File & Page
fields. (Depending on the film mode you have
selected, some of these fields may be inactive.)
When finished click the Search button, the Search
& Scan button or press the Enter key. This will
search for the desired address and display the
appropriate images (Search & Scan).

You may select any or all of the following options at
this time. For more information on these options, see
the IDW Scanning Control and Print Options
sections of chapter one.

» Rotate Print 90 degrees
» Fit Image to Print Page
» Automatic Print

Click the Scan button. The most recently defined
check scan areas (or the areas stored in the loaded
profile) will be used by the IDW to scan the front and
back of the check. The combined image is displayed
on the screen.

If either the front or back image is not acceptable it
may be rescanned. Click on the Scan Front (or Scan
Rear) button. The IDW will do a full screen scan of
the appropriate side and the image will display.

Using your mouse, position the mouse cursor over
the upper left-hand corner of the front check image.
Click the left mouse button, holding it down, and
drag the mouse cursor to the lower right-hand corner
of the front check image. You will notice an opaque
white box covering the area you have just dragged
your mouse over. When you have covered the image,
release the mouse button.

DIDS will combine the selected image with the
existing back (or front) and redisplay the combined
image on the screen.

IDW Scanning Control

— Film Location Information

Block File: Page
Current Address
I I I 0
Search Address
— Film Po=itioning Controlz
Search Preset Eject
Search & Scan = Load
Scan Scan Front Scan Rear
— =earch Interval
) Block " File {* Page

K=

r I 1
— Check Scan Exposure

{~ Baze { Simplex {* Duplex ¥ Check
Front Image Exposure

.ﬂ N -

Rear Image Exposure

{ T
IMedium | Fim |fo | aec
IText vI [T Threshold Processing
1 >| 120

— View Properties

Front Rear Skew

—Automatic Functions

Auto Sean Betch =can

Fun Regizter

Total Scans - 495, Total Prints -2
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7. At this point you can use the Image Enhancement and Annotation tools to perfect your
images. For more information on using the enhancement tools, see the section in this chapter
on Using the Image Enhancement and Annotation Tools.

8. To deliver your image you can choose:

Print from the Toolbar to print to the Windows default printer.

Press P to print to the Windows default printer.

Send from the Toolbar to e-mail your image as an attachment.

Press Ctrl-2 to e-mail your image as an attachment.

Press X to fax your image.

The Main Menu File option followed by Print option and choose your fax print driver (or the
Fax option) to fax your image.

Press U to publish your image.

The Main Menu File option followed by the Save or Save As option to save your image.
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Scanning Duplex Film Images

To scan duplex images please use the following steps:

1.

Click on the Duplex radio button, located in the
lower half of the IDW Scanning Control
window.

Enter the search address in the Block, File &
Page fields. (Depending on the film mode you
have selected, some of these fields may be
inactive.) When finished click the Search button
or press the Enter key. This will search for the
desired address. Using the Search & Scan
button will also display the appropriate image.

You may select any or all of the following options
at this time. For more information on these
options, see the IDW Scanning Control and
Print Options sections of chapter one.

» Rotate Print 90 degrees
» Fit Image to Print Page
» Automatic Print

Note: If you have a printer that has a Duplex
Print mode, click the Automatic Print option to
print duplex images on the front and back of the

page.

Click the Scan button. The most recently defined
duplex scan areas (or the areas stored in the
loaded profile) will be scanned by the IDW and
side 1 will be displayed. The Scan button will
display Side 2.

If either the front or back image is not
acceptable it may be rescanned. Click on the
Scan Front (or Scan Rear) button. The IDW will
do a full screen scan of the appropriate side and
the image will display. Using your mouse,
position the mouse cursor over the upper left-
hand corner of the front check image. Click the
left mouse button, holding it down, and drag the
mouse cursor to the lower right-hand corner of
the front check image. You will notice an opaque
white box covering the area you have just

IDW Scanning Control

— Film Location Information

Block File: Page
Current Address
Search Address
| | | 0
B Film Pogitioning Controlz
Search Preset Eject
Search & Scan = >
Scan Scan Front Scan Rear
— =earch Interval
) Block " File {* Page

o | o[

— Duplex Scan Exposure
{~ Baze { Simplex % Duplex { Check

Front Image Exposure

.ﬂ N -

Rear Image Exposure

{ T
IMedium | Fim |fo | aec
IText vI [T Threshold Processing
1 >| 120

— View Properties

Front Rear Skew

—Automatic Functions

Auto Scan Batch Scan

Fun Regizter

Total Scans - 496, Total Prints -2

dragged your mouse over. When you have covered the image, release the mouse button.

The first image will be displayed. At this point you can use the Image Enhancement and
Annotation tools to perfect you images. To see the second image, click the Side 2 button




located on the IDW Scanning Control window. Again at this point you can use your Image
Enhancement tools. For more information on using the enhancement tools, see the section in
this chapter on Using the Image Enhancement Tools.

7. To deliver your image you can choose:

Print from the Toolbar to print to the Windows default printer.

Press P to print to the Windows default printer.

Send from the Toolbar to e-mail your image as an attachment.

Press Ctrl-2 to e-mail your image as an attachment.

Press X to fax your image.

he Main Menu File option followed by Print option and choose your fax print driver (or
the Fax option) to fax your image.

Press U to publish your image.

The Main Menu File option followed by the Save or Save As option to save your
image.

VVVVYVYVYYV

\ 2%
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Scanning Simplex Film Images

To scan simplex images please use the following steps:

1.

Click on the Simplex Images button, located in
the lower half of the IDW Scanning Control
window.

Enter the search address in the Block, File &
Page fields. (Depending on the film mode you
have selected, some of these fields may be
inactive.) When finished click the Search button or
press the Enter key. This will search for the
desired address. Using the Search & Scan button
will also display the appropriate image.

You may select any or all of the following options
at this time. For more information on these
options, see the IDW Scanning Control and
Print Options sections of chapter one.

» Rotate Print 90 degrees
» Fit Image to Print Page
» Automatic Print

Use the View Properties — Front or View
Properties — Rear button to move the film to the
correct channel. Click the Scan button. The most
recently defined simplex scan area (or the area
stored in the loaded profile) will be scanned and
displayed.

If the image is not acceptable it may be rescanned.
Click on the Scan Front (or Scan Rear) button. The
IDW will do a full screen scan of the appropriate
side and the image will display. Using your
mouse, position the mouse cursor over the upper
left-hand corner of the front check image. Click the
left mouse button, holding it down, and drag the
mouse cursor to the lower right-hand corner of the
front check image. You will notice an opaque white
box covering the area you have just dragged your
mouse over. When you have covered the image,
release the mouse button.

At this point you can use the Image
Enhancement and Annotation tools to perfect
your image. For more information on using the

IDW Scanning Control

— Film Location Information

Block File Page
Current Address
Search Address
| | | 0
— Filmn Po=itioning Controls
Search Pre=set Eject
Search & Scan s e
Scan Scan Front Scan Rear
— Search Interval
) Block " File {* Page

o | o[

— Section Exposure
{~ Baze {* Simplex { Duplex { Check

Front Image Exposure

i I d D

Rear Image Expozure

{ 0 g
IMedium | Fim |fo | aec
ITE:lCt 'I [T Threshold Processing
ﬂ hl 120

—View Propertiez

Front Rear Skew

—Automatic Functions

Auto Scan Batch Scan | Run Register

Total Scans - 495, Total Prints -2

enhancement tools, see the section in this chapter on Using the Image Enhancement and

Annotation Tools.

To deliver your image you can choose:
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Print from the Toolbar to print to the Windows default printer.

Press P to print to the Windows default printer.

Send from the Toolbar to e-mail your image as an attachment.

Press Ctrl-2 to e-mail your image as an attachment.

Press X to fax your image.

The Main Menu File option followed by Print option and choose your fax print driver
(or the Fax option) to fax your image.

Press U to publish your image.

The Main Menu File option followed by the Save or Save As option to save your
image.
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Creating and Maintaining Multi-Page TIFF Files

The Digital Image Delivery System provides complete support for Multi-Page TIFF files. A Multi-Page
TIFF file is a TIFF file that contains more than one image. In DIDS these files always have the
extension .mpt and are referred to as MPT files. This format provides great flexibility for storing like
images (such as all the images of a photocopy request) and e-mailing or transferring the images as a
group rather than one at a time.

DIDS offers many tools for creating MPT files. The simplest method is to open an image (or scan an
image) then select File -> Save As -> Multiple Image; DIDS will suggest a random file name, accept it
or change it, DIDS will automatically append the .mpt extension. This action sets the MPT to the
“current MPT” and the MPT button on the toolbar will display the MPT file’s name. The image title will
also change to the MPT file name and list the page number.

To change the “current MPT” to an existing MPT file, simply open the MPT file in DIDS. The simplest to
open the file is select File-> Open File; pull down the list labeled “Files of Type” and select “Multi-Page

Open File Ed
S .o = &) @ e
Bl] carrall.mpt MS13291.mpt MSI42B5.mpt
B MSIT1EZmpt B MSI4145 mpt 1] MS142F 1 mpt

EI| MSI1ET.mpt
] M5 2E T mpt
| MS12240.mpt
E] MSI31ED mpt

MSI 7052, mpt
MSI7324.mpt
MSIS18T.mpt
MSI8332. mpt

MSIC150.mpt
[SFMSIC311.mpt
MSID275 mpt

File name: — [MSIC311.mpt W Enable Preview

Open I
j Cancel |
Eile Info |

Files of type: | MultiPage Files [~ mpt)

Fage Mo

IB Delete Page |

Files (.mpt)”. Then select the MPT file (it may be necessary to navigate to a different folder using
standard Windows methods). If “Enable Preview” is checked this dialog box displays a thumbnail of
the page in the Page No. box, this allows the user to locate a page within an MPT without opening the
MPT by simply typing in the page number. The page listed in the Page No. box can be deleted by
clicking on the Delete Page button. Clicking on the File Info button displays information about the page
selected. Click on Open and DIDS will open the file in “MPT View”. This viewing method displays the
images one page at a time and provides a simple dialog for navigating within the MPT file:
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As the scroll bar is moved or the page number is changed a thumbnail view of the page is displayed.

Load Page — Clicking on Load Page displays the selected image on the main window. The image
may be annotated or edited using the image and annotation tools.

Save Page - Clicking on Save Page saves the changes.

Delete Page — Clicking on Delete Page deletes the page from the MPT View (and the MPT File).
Close MPT View — Clicking on Close MPT View closes the MPT View window and saves all changes

to the mpt file. The mpt file is still the active [N T CGNEE |
mpt file and additional images may be added
using the Add to MPT button. lijj]/{_‘fé £ Pages

. Select Page for Viewing
Another method of opening an MPT and ——

changing the current MPT to an existing MPT file
is to browse an MPT in thumbnail mode. This Claze MPT
method provides more navigation and flexibility Wiew
in working with an MPT but is a slower method I_ - ,
of loading the file and requires more memory 3 J J J
and computer resources. Select File -> Browse

MPT File from the menu. This will display the
dialog box for selecting the MPT (this dialog is the same as the one described above). After selection
the MPT will be opened in a thumnbnail browse mode.
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The loading speed may be increased by removing the check on the “Favor Quality over Speed when
loading thumbnails” selection in the Configuration Screen (Options -> Configuration).

To navigate within this view use the scrollbar on the right hand side to move through the thumbnails
(when there is more than one page). Clicking on an image will select it and display it in an editable
view. To select an image or a group of images without displaying it hold down the CTRL while clicking
on the thumbnail. Selected thumbnails will display in blue.

There are two menu options on the browse view window; File is for operations that affect all of the
images, Image is for operations that affect only the selected image(s).

File
Eile lmag'j’ , Save As —allows saving all of the images in the thumbnails as a new MPT file.
izl Rll= Print — prints all of the images in the thumbnails to the default printer.
Save fs ¥ | Fax — faxes all of the images in the thumbnails.
. Publish — publishes all of the images in the thumbnails to the Internet or an
Erititen Setiug Intranet
E"nt Send — creates an e-mail message with an MPT file containing all the images in
o8 the thumbnails attached.
Publizh Close — closes the browse view and returns to the standard DIDS menu.
Send i
Cloze
Image
< Remove Selected Image(s) — removes the selected
Image image(s) from the view, does not remove the pages

Remove Selected Image(z]
Print Selected Image(z]

b ail Selected Image(z]
Publizh Selected Image(z]
Fax Selected Image|z]

from the MPT.

e Print Selected Image(s) — prints the selected images
to the default printer

¢ Mail Selected Image(s) — creates an e-mail message
with an MPT containing the selected image(s) attached.

¢ Publish Selected Image(s) — publishes the selected

image(s) to the Internet or an Intranet.
 Fax Selected Image(s) — faxes the selected image(s).

Thurnbnail
i
Claze Current Image

Add to MPT

Test.mpt

When the thumbnail browse window is displayed an additional button
labeled “Thumbnail View” is added to the toolbar. Clicking on this
button closes the selected image or the Thumbnail View.

The name of the “Current MPT” is always displayed below the Add to MPT button on
the toolbar. To add an image to the MPT display the image, either by opening it or
scanning a new image, then click on the Add to MPT button on the toolbar. The name

displayed on the image window will change to reflect the MPT and the page number.
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Faxing an Image

The Digital Image Delivery System can use any standard Windows Fax Printer Driver for faxing images,
however there are several features that are available only when DIDS is used with Winfax Pro. Install
Winfax Pro following the instructions received with Winfax Pro. Setup the phonebook and modem as
described in the Winfax Pro manual. These instructions assume the use of Winfax Pro.

If Winfax Pro is available DIDS will automatically fax images in response to CAR commands.

It is very easy to fax an image, or a group of images, from DIDS. Simply display the image (or
| the browse view) and either click on the Fax button on the toolbar or depress the X key when
Fax the image window is active. DIDS will open the Fax Send screen. Typically this includes a
cover sheet (the cover sheet may be customized within Winfax Pro) and a thumbnail of the
image(s) to be faxed. Simply select the phonebook entry or enter the fax information and click on the
Send button. The fax will be sent and maintained as per the Winfax Pro Setup. If there are more
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images to be sent to the same fax recipient, leave the Send screen open (do not click on Send), and
click on DIDS title bar with the mouse. Now bring up the other images, either by scanning them or
opening them. Each time the Fax button on the toolbar (or the X key) is clicked the open image(s) will
be added to the fax. When the fax is complete, switch over to Winfax Pro using ALT-Tab and click on
the Send button.
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Winfax Pro will maintain logs of the faxing operations and allow re-faxing of images which are not
received. These logs and length of time that images are available for re-faxing depend upon the
Winfax Pro setup. Please see the Winfax Pro manual for more details.
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E-Mailing an Image

The Digital image Delivery System uses the default SMTP mail program to e-mail images. Generally,

any MAPI-Enabled e-mail program can be used. If Lotus Notes is to be used the client must be R5 or
above or the client must have been patched to allow MAPI-compliance (see the Lotus Notes web site
for more information).

(or the browse view) and either click on the Send button on the toolbar or depress the CTRL-2
Eend [ K€Y When the image window is active. DIDS will create an e-mail message with the image
attached. Simply add the e-mail address, subject and any additional messages then click on
the Send button.

The recipient must have a program for ™ Untitled - Message (HTML) IM[=] E3

viewing the images. If the image is a TIFF J
file or an MPT it can be viewed using the J

‘. It is very easy to e-mail an image, or a group of images, from DIDS. Simply display the image

File Edit ‘ew Insert Format Tools Ackions Help

=[] - » : - ol
Windows Imaging program that has Elznd - H & | U - J Arial -
shipped with Windows since Windows 95 B. |ﬂ - . 0 X

|15 Message Nas not been sent.,
If Lotus Notes is being used as the mail
. . To..

program (see information above) the LI I
recipient can view the TIFF files in Notes if cc... | |
they have R4.6.2 or above. |

Subiject:
As an alternative, the image can be saved :l

as a JPEG file or a PNG file before e-
mailing, these images are viewable in a
browser.

PSI2345.tif
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Publishing an Image

The Digital Image Delivery System has the ability to Publish an image or group of images to an
Internet or Intranet location. The image(s) are sent as JPEG images and may be viewed in a Web
Browser. This option also creates an e-mail message containing the URL of the image. The e-mail
message is created using a template.

To publish an image or group of images display the image (or browse view) and click on the
Publish button on the toolbar or depress the U key when the image window is active. This will
display the Publish on the Internet window (if you do not need to change any of the
information on this window, check the “Do Not Show This Again” option, if it is necessary to
turn this window back on, check the “Show FTP Information” option on the Configuration screen).

Send — Click this button to initiate .
the ftp transfer or file save. Publish on the Internet |
Cancel — Click this to cancel the
ftp transfer.

FTP Server ldentification — —
Enter the name of the ftp server. FTP Server |dentification: |

Publish image to folder — enter
the full path of the destination
folder on the server.

Web address of image — Enter | /images
the URL of the destination folder.
If the URL begins File:// DIDS will

Iftp.sewer.u:u:um

Publizh image to folder:

Wieb addrezs of image

send the image to a local folder (in [t . company. com/images/

this case the “Publish image to

folder” space must contain a fully Uszer Mame: |L|$erName

qualified local or network path).

User Name — Enter the user login Pazsword: | W Save Password

name for the ftp server.
Password — Enter the login
password for the ftp server.

Save Password — If this is clicked
the password will be saved in the
INI file, please note that the saved B DD e T B
password is not encrypted.

E-tail Template IE:'\F‘ngram Filezhimzdids\request.tpl
Quality % Best [large image] ¢ Better [medium image] ¢ Good [zmall image]

& FullSize © 1/25ize  1/3 5ize

E-Mail Template — Contains the
name of an HTML file containing the template for the E-Mail Message. The template can contain
any valid HTML but must include a line that reads: <INSERT LINK>

Do Not Show This Again — If this is checked, this window will not display and DIDS will use the
saved information.

Full Size / %2 Size / 1/3 size — DIDS will resize the image before sending it to the destination
folder.
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The following image shows a sample E-Mail message created with a template. The template used for
this message is on the next page.
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<html>

<head>

<meta http-equiv="Content-Language" content="en-us">

<meta http-equiv="Content-Type" content="text/html; charset=windows-1252">
<meta name="GENERATOR" content="Microsoft FrontPage 4.0">

<meta name="Progld" content="FrontPage.Editor.Document">

<title>New Page 1</title>

</head>

<body bgcolor="#33FFFE">

<p><img border="0" src="c:\progra~21\Intell~1\msilogo.jpg" width="265" height="96"></p>
<p><font face="Arial" size="4">Please click on the following to view your image:</font></p>
<INSERT LINK>

<p>&nbsp;</p>

<p><font face="Arial" size="4">This image was produced using Micrographic

Sciences' Digital Image Delivery System.</font></p>

<p><font face="Arial" size="4">The original microfilm was scanned using a Kodak

Imagelink Digital Workstation.</font></p>

<p><font face="Arial" size="4">To learn more about this technology visit our web

page <a
href="http://www.micrographicsciences.com">www.micrographicscience.com</a></font></p>
<p>&nbsp;</p>

</body>

</html>
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Using the CAR Emulator

The Digital Image Delivery System has the ability to interpret downloaded CAR commands and perform
the indicated actions. DIDS does not support any direct CAR commands.

The CAR commands supported by DIDS are a subset of the commands supported by the IDW and are

listed in Appendix C.

. An optional component (DIDSCAR.EXE)
Change Rulll I Continue [F1] is required to download the CAR
_ _ _ cl commands. DIDSCAR.EXE must reside
Clear Registers | akip F’Legmterl nse in the application folder and requires a
Curremnt Iﬁi = ltem =earch Mode [F12] irt(;?tSpOM port and is usually run at
Register € Oftest I Flip 907
Current Message: FolderF1348608 Click on the Run Register button on
LOAD ROLL 04-15-99 B 07497 the IDW Scanning Control to run a

stored download.
Frevious Message: Fesources =

This will display the Run Register
Contents window. The Current
Register box will contain the lowest
numbered register present.

T Folderlmages T Testkiode [T Semi-Automatic

I Brinit Arnatatior Click on the Start [F1] button to

initiate the download execution (the
button’s caption will change to Continue [F1]). The Current Register box will list each register as it is
performed. The Current Message Space will display information for the operator, similar to the small
LCD screen on the IDW. As the operator performs requested tasks, clicking on the Continue button
will advance to the next register.

To begin at a different register or skip to a different register, type the roll number into the Change
Roll box and click on Change Roll.

In response to the Search command DIDS will advance the film to the correct image location. The
operator is responsible for scanning the correct image. Once the correct image is displayed the
operator clicks on the Continue button to advance to the next register.

If annotations received in the download are to be printed on the image, the Print Annotation option
must be checked. The annotations will be printed in the location and in the font selected in the
Configuration screen (Options -> Configuration). DIDS will ignore any annotation placement
commands received in the download.

If the images are to be foldered on an ANF Server (an optional product) or an IDW+ Node the Folder
Images option must be checked and the node must be available on the network.

If the Test Mode option is checked, DIDS will display each command before execution.
If a fax command is received in a download (and Winfax Pro is present), DIDS will prepare the fax and
automatically send it. By default DIDS displays a Fax Wizard that allows the operator to verify fax

information (or add other documents). This wizard will not be displayed if the file node.ini is present in
the windows folder and contains the following lines:
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[DIDSFAX]
AutoSend=1

If the fax wizard is displayed the operator may click on the Send button if everything is okay, or double
click on the recipient and modify the options or add another recipient. To add an attachment, select
the Winfax Pro Attachments button. To add or modify the default cover page select the Cover Page
Tab.

The General Properties tab allows the subject line to be changed, the fax to be previewed, the fax
resolution to be changed and fax deletion settings to be modified.

After all changes have been made, return to the Recipients tab and click on the Send button.
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Using the Image Enhancement and Annotation Tools

The Image Enhancement and Annotation tools are provided to help you perfect your scanned images
to the quality you customers desire. The Annotation toolbar is located at the top of the screen. The
Image Enhancement Tools can be accessed from the Image menu option on the Main Toolbar or
pressing the “M” key on the keyboard will display a pop-up menu of these tools.

Refer to the list of tools below on the instructions on their use. Refer the Image Annotation Toolbar
section in chapter one for a description of the purpose of these tools:

E Digial | mage Delvsp Sealem - L WPiogiam Flexdatelhgenl Hesomage 5cannizi\Jbhald30 mai

Y @ ANDoCazy AmmDsis |

E Click the Save button (the disk icon) to save changes to the current image using the current
name.

Save

0y

‘ =# Click the Print button to print the image to the default printer.

Click the Fax button to fax the current image.

‘E Click the Send button to automatically run the mail program, create a new message and inserts
Send |

the image. DIDS uses the Windows default SMTP mail program.

Click the Publish button to publish the image to the Internet or an Intranet.

XXXXXXXX.mpt Click on the xxxxxxxx.mpt button to add the current image to the
named MPT file.

Test.mpt

k Click on the Select button to cancel the current tool and return to select mode.

Select

Click the Line button and move your mouse to the display window. Position the mouse over the
|\~""-..| image where you wish to start the line. Click and hold the left mouse button down. Drag the
: mouse to where you wish the line to end. When you are satisfied with the position of the line,
Line"  release the mouse button.
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Click the Rectangle button. Position the mouse over the image where you wish to start the
‘g rectangle. Click and hold the left mouse button down. Drag mouse in a diagonal line until the

rectangle meets the desired size. When you are satisfied with position of the rectangle, release
the mouse button.

Rect

I.':::I Click the Ellipse button. Position the mouse over the image where you wish to start the
ellipse. Click and hold the left mouse button down. Drag mouse in a diagonal line until the
Ellipse meets the desired size. When you are satisfied with position of the ellipse, release the
mouse button.

Elipze

E Click the Polyline button. Position the mouse over the image where you wish to start the

polyline. Click and hold the left mouse button down. Drag the mouse to where you would like
the first line to end and release the mouse button. Repeat clicking, holding and dragging until
you are satisfied with the position of you line. When you are satisfied, double click the left mouse
button to set you line in place.

t Pline

E Click the Polygon button. Position the mouse over the image where you wish to start the
Pgon Polygon. Click and hold the left mouse button down. Drag the mouse to where you would like
the first line to end and release the mouse button. Repeat clicking, holding and dragging until
your last line meets your first line. When you are satisfied with the position of you polygon box, double
click the left mouse button to set it in place.

.ll"in Click the Arrow button and move your mouse to the display window. Position the mouse over
&row  the image where you wish to start the line. Click and hold the left mouse button down. Drag
the mouse to where you wish the line to end. When you are satisfied with the position of the
line, release the mouse button.

Click the Free Hand button. Position the mouse over the image where you wish to start the
line. Click and hold the left mouse button down. Drag mouse in a until the line meets the

t Free | desired pattern or form. When you are satisfied with position of the line, release the mouse
button.

Click the Hilite button. Position the mouse over the image where you wish to start the hilite
box. Click and hold the left mouse button down. Drag mouse in a diagonal line until the
rectangle meets the desired size. When you are satisfied with position of the rectangle, release

Hilite: F
e the mouse button.
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Click the Redact button. Position the mouse over the image where you wish to start the
. redact box. Click and hold the left mouse button down. Drag mouse in a diagonal line until the
Sedact rectangle meets the desired size. When you are satisfied with position of the rectangle, release
the mouse button.

H D Click the Text or Note button. Next, click and hold the left mouse button down. Drag
[Test Mote Mouse in a diagonal line until the rectangle meets the desired size. When you are satisfied

with position of the rectangle, release the mouse button and this will insert your text
message. This will display the Enter Text window. Type in the text you wish to insert and then click the
OK button.

The only difference between a Note and a Text message is the Note message has a non-transparent
background and the Text message has a transparent background.

Click the Logo button. Position the mouse over the image where you wish to place the logo
J@ image. Click and hold the left mouse button down. Drag mouse in a diagonal line until the

rectangle meets the desired size. When you are satisfied with position of the rectangle,
release the mouse button and this will insert the DIDS logo. To change this logo to your own,
see the section in chapter one on the Main Menu. The Configuration option is located in the Eile
topic.

Logo

Stamp
Ig Click on the Stamp button to draw a pre-defined “Rubber Stamp” on the image. There is no

keyboard equivalent.
Stamp

Note: After drawing any of the objects listed above, you can right click on the object to
provide a menu for modification.

& Click the Magnify button, this will display your mouse cursor as a magnify glass. Move your

mouse over the image you wish to zoom in on and click, holding the left mouse button
Magnifiy, down. To zoom to another area of the display window, continue holding the mouse button
down and drag the mouse. You will notice the zoomed portion of the image displayed in the lower
right-hand corner of the screen. Releasing the mouse button will deactivate the magnify option. To
reactivate magnify option, click the Magnify button again or press the Ctrl + G key.
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Image Enhancement Tools

The Image enhancement tools provide you a way to fine-tune or perfect the quality of your images. For

a complete description of functions of these tools, please see the Main Menu section of chapter one,

sub topic “Image”. You can activate the Image Enhancement Menu by pressing the “M” key on the
keyboard.

The tools listed below operate similarly, although they have different effects on your image.

» Brighten — Ctrl+B Key

Cancel

Remove Region

Border Removval

Zoom Section

Rewvert

tiesnecklE » Contrast — Ctrl+C Key
| Deskew | > Despeckle — Ctrl+D Key
= > Sharpen — Ctrl+S Key

| Brighten I
| E qualize | To use these tools use the following steps:
| Ivet I 1. Press the desired tools shortcut key or press the “M” key to display the
| Cantrast | Image Enhancement Menu and click on the desired tool button.
| Sege I Sharpen
: e : Percentage

Halftone

ul I—E - :
| Smoath I J J J
| Bemove Dats I o
| Set Beqgion | |—I
| | e |
| |
| |
| |
| |

Claze Menu

results. The change will display on the thumbnail.

abort the change.

3. Click the OK button to apply the change. Click the Cancel button to

The tools listed below are single click tools. When you select any of the following tools the image is
automatically adjusted for you. You can activate these options by pressing the associated shortcut key
or Press the “M” key to display the Image Enhancement menu and click on the desired tool button.

VVVYVY

Deskew — Ctrl+K Key
Equalize — Ctrl+Q Key
Invert — Ctrl+1 Key
Grayscale — Ctrl+G Key
Halftone — Ctrl+H Key
Revert — Ctrl+V Key

2. Move the scroll bar left or right to add the desired positive or negative
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The next two tools act on Bitonal images only.

Remove Dots from

) ) Dot Removal
Bitonal Images - finds

X
and removes dots, specks, -~ Flags : ok I
and blobs of various sizes I [Use DPI |dpii
in _1—b|t (B_|tonal) image. W Use Dot Dimersions Cancel |
This function works only
on 1-bit black and white ¥ Usze Diagonals
images. If a region is _ _
selected, only the selected ~ Dot Dimensions
region will be changed by Wirirum Dot aidth |1 .
this function. If no region pitels
is selected, the whole Miriruim Dot Height |1 pixels
image will be processed. _ _
This is similar to the Mazimum Dot idth I pinels
Despeckle option except : . _
the user may specify the P a=irurn Dot Height |5 pizels

exact size of dots to be
removed.

Smooth Bitonal Images — smooths the text in scanned text documents. This function works only
on 1-bit black and white (Bitonal) images. If a region is selected, only the selected region will be
changed by this function. If no region is selected, the whole image will be processed.

Smooth |

Smooth Options

Bumps/Mick Length I'I

% Favor Long Bumps/Micks
™ Favor Short Bumps/Micks

Canicel |

The remaining Image Enhancement Tools help in perfecting a specific area of the image. The Set
Region tool works in conjunction with the tools listed above, e.g., If you have a check image with a
background picture you may wish to brighten just this area of the image. To perform this task you
would use the Set Region tool to define the area you wish to adjust, followed by the Brighten tool to
enhance the image.

Please use the following instruction in using the Set Region tool:

1. Press the Ctrl+R Key or Press the “M” Key and click the Set Region button from the Image
Enhancement Menu.

2. Position the mouse over the image where you wish to start the region box. Click and hold the
left mouse button down. Drag mouse in a diagonal line until the rectangle meets the desired
size. When you are satisfied with position of the rectangle, release the mouse button.

3. Enhance the selected area of the image by pressing the desired enhancement tools shortcut
key or press the “M” key to display the Image Enhancement Menu and click on the desired tool
button.
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4. When you are finished enhancing the image area, remove the region by pressing the Ctrl+M
key or by selecting the Remove Region tool option from the Image enhancement Menu.

The dotted
line around
the image

indicates a

region is set.

Ll [
Tl
¥ o 7 1Bfeer 3 ey
e ™
T VAR R M
= Pera qeve |
ﬂ J I'I (L]

[ CoMEE Hghe |

[ —

|- ke 5oy | rn-nf---\.lnn-”

| D S Erpans Basa |
Tk B - 71, Bk T

The final Image Enhancement Tool you need to know how to use is the Border removal tool. Please
use the following instruction in using the Border Removal tool:

1. Press the Ctrl+0O Key or Press the “M” key and click the Set Region button from the Image

Enhancement Menu.

2. Position the mouse over the image where you wish to start the region box. Click and hold the
left mouse button down. Drag mouse in a diagonal line until the rectangle meets the desired
size. When you are satisfied with position of the rectangle, release the mouse button.

3. Repeat step 2, covering each individual area of the image that you wish to keep with a region

box.

4. When you have finished setting the region box(s), click the right mouse button. This will
remove all areas of the image that where not inside a region box.

50




Working with Folder View

DIDS creates and reads single page and multi-page TIFF files. Multipage TIFF files contain more than
one image. In DIDS these files have a .mpt extension. DIDS provides several tools for creating MPT
files. The most versatile is the Folder View.

To open a Folder in Folder View, choose File -> Open Folder option from the main menu. Select the
folder. DIDS will load the images, display the first page and display the Folder View Control window.
This control allows display, manipulation and editing of individual images in the folder and creation of
and manipulation of an mpt file. To open an existing MPT file in Folder View, select File -> Open File
and select an existing MPT file.

As the scroll bar is moved or the page number
is changed a thumbnail view of the page is
displayed.

Load Page — Clicking on Load Page
displays the selected image on the main
window. The image may be annotated or
edited using the image and annotation
tools.

Save Page - Clicking on Save Page saves
the changes.

Delete Page — Clicking on Delete Page
deletes the page from the Folder View.

Close Folder View — Clicking on Close
Folder View closes the Folder View window
and saves all changes to the mpt file. The
mpt file is still the active mpt file and

C:AlM5himagesiM 512345 tif

]|

[F777777772 10 Pages
| e 7
Select Page far YWiewing =ave Page |
ey Delete Page |
Close Folder
Wiy
|1 4 | | r
Yiewy Previous Page | “iewy Mext Page |
Start MPT | Ad to MPT | Add to MPT and advance |

| current MPT: Mome

additional images may be added using the Add to MPT button.

View Previous Page — Clicking on View Previous Page decrements the page number and displays

the previous page.

View Next Page - Clicking on View Next Page increments the page number and displays the next

page.

Start MPT — Clicking on Start MPT saves the current image as a new mpt file.

Add to MPT - Clicking on Add to MPT adds the current image to the mpt file.

Add to MPT and advance — Clicking on Add to MPT and advance adds the current image to the

MPT and displays the next image.
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Transferring an image to another application

Pressing the W key facilitates transferring a section of the image to a word processing document. To
best use this option it is necessary to set up templates in your word processor that include macros to
insert and position your image.

1. Press W, DIDS will prompt “Select area to be transferred to Word Processor Document”. Click
OK. + Digital Image Delivery System

2. Select the area to be transferred by
using your mouse. Position the mouse
cursor over the upper left-hand corner of
the desired area. Click the left mouse
button, holding it down, and drag the
mouse cursor to the lower right-hand corner of the area. You will notice an opaque white box
covering the area you have just selected.

Select area to be transferred to Word Processzaor Docurment

3. DIDS will display a dialog box requesting the shortcut or template to open.

4. Select the shortcut or template.

5. DIDS will open the application referenced by the shortcut or template. If there is a startup
macro that pastes the image the application will execute it.

JI-IIII.III'_'I""I' el - W owmed | Y ol

e gl e eer Fma (i (i grdos e |
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[ e ot Jrs[HEYy S L.

| |

0] e

|_ BANK & TRUST CO.

Wadnegaling, January 13, 1598
M, Jokr Dos

1224 ving Sineat
fshiabuls, Cihio 26878

Daar by, Dos:

Fleais acospl thit redpanse Io your réquedt for infiamalion concenming Se Bem
deposiled ba your acceurt £ 1737-4567-890 on January 10
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6. Sample shortcut - “C:\Program Files\Microsoft Office\Office\WINWORD.EXE”
mNormal.NewMacros.Macrol This will run Microsoft Word and execute the macro
NewMacreo.Macrol in the Normal.dot template.

7. Sample macro —

Sub Macro1()

‘ Macrol Macro

Documents.Add Template:= _

“C:\Program Files\Microsoft Office\Templates\MICROGRAPHICs.dot”, _
NewTemplate:=False

Selection.MoveDown Unit:=wdLine, Count:=17

Selection.TypeParagraph

Selection.Paste

Selection.Paste

ActiveDocument.Shapes(“Picture 2").Select
Selection.ShapeRange.ScaleWidth 0.62, msoFalse, msoScaleFromTopLeft
Selection.ShapeRange.ScaleHeight 0.62, msoFalse, msoScaleFromTopLeft
ActiveWindow.ActivePane.LargeScroll Down:=-2
Selection.ShapeRange.IncrementLeft 32.4
Selection.ShapeRange.IncrementTop -1.25

End Sub

This macro will open the template Micrographics.dot, insert and position the image.

You may now use the Word Processor’'s menu to print, save, e-mail, etc..
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Zoom in on a Section of the Image

Pressing the Z key allows the selection of a section of the image and reinsertion of the enlarged
section. This provides a quick and easy method of emphasis.

1. Follow the previous instructions to obtain the image.

2. Press the letter Z. The cursor will momentarily change to a crosshairs and the message “Select
area to be zoomed” displays. Click on OK to clear the message.

3. Select the area to be enlarged by using your mouse. Position the mouse cursor over the upper
left-hand corner of the desired area. Click the left mouse button, holding it down, and drag the
mouse cursor to the lower right-hand corner of the area. You will notice an opaque white box
covering the area you have just selected.

4. When the mouse button is released the selected section will be copied, enlarged and reinserted
in its original position.

5. To move the enlarged portion, select it with the mouse and drag it (holding down the left
mouse button and moving the mouse) to the location.
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Appendix - A

Miscellaneous keyboard options

Ctrl-A Selects the Arrow tool.
Ctrl-B Brightens the image.

Ctrl-C Adjusts the contrast of the image.
Ctrl-D Despeckles the image.
Ctrl-E Equalizes the image.

Ctrl-F Selects the Free Hand tool.
Ctrl-G Selects Magnify mode.
Ctrl-H Selects the Hilite tool.

Ctrl-I Inverts the image.

Ctrl-K Deskews the image.

Ctrl-L Selects the Line tool.
Ctrl-M Cancels the region selection.
Ctrl-N Selects the Note tool.
Ctrl-O Selects the Logo tool.
Ctrl-P Selects the Polyline tool.
Ctrl-R Allows selection of a region.
Ctrl-S Sharpens the image.

Ctrl-T Selects the Rectangle tool.
Ctrl-Y Selects the Polygon tool.
Ctrl-X Selects the Text tool.

Ctrl-0 Selects the Ellipse tool.
Ctrl-1 Selects the Redact tool.
Ctrl-2 E-Mails the image.

Ctrl-3 Prints the image.

F1 Inserts Message 1

F2 Inserts Message 2

F3 Inserts Message 3

F4 Inserts Message 4

F5 Inserts Message 5

F6 Displays the last Section selection.

F7 Displays the last front and back image selections.
F8 Displays the % of toner coverage

F9 Removes the black border using Software removal.
B Reprocesses the Base Scan.

C Reprocesses the front and rear images.

E Sets Text & 256 Gray Mode.

F Reprocesses the front image.

M Displays the image menu.

P Prints the image.

Q Sets 256 Gray Mode.

R Reprocesses the rear image.

S Reprocesses the Section scan.

T Sets Bitonal Mode.

X Faxes the image.



Home — Loads the microfilm.

End — rewinds and unloads the microfilm.

Page Up — advances the film 1 screen and displays the image

Page Down — moves the film 1 screen in reverse and displays the image
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Appendix B

INI Settings

Many of the settings for DIDS are stored in the IDWDIDS.INI file in the windows directory. Most
settings are set and maintained by DIDS, however there are a few that may be manually changed to
affect the behavior of DIDS. To change these settings open IDWDIDS.INI in notepad or another text

editor.

[MSIDIDS]

ProductName=Digital Image Delivery System

BatchScan=TRUE
ImageSize=Center
RubberStamp=8
imagepath=C:\IDW\images
folder=

mail=

node=
datetimestamp=FALSE
messagelstamp=FALSE
tiff_files=1
FlipBack=TRUE
ShowFTP=TRUE
UseNames=FALSE
TotalScans=3172
logo=msisym.bmp
SkipBlanklmages=FALSE
MinPctCoverage=

text1=Courtesy of your finantial institution

text2=Confidential
text3=Do Not Copy
text4=Best Possible Copy
text5=Confidential
ProfilePrompt=1
TestMode=0
MessageFontSize=75
Fax=WinFax
FontSize=75

[EASTMAN KODAK_WINDOW_2]

TestMode=FALSE
ToolRect=TRUE
ToolEllipse=TRUE
ToolPolygon=TRUE
ToolPointer=TRUE
ToolFreehand=TRUE
ToolArrow=TRUE
ToolHilite=TRUE
ToolRedact=TRUE
ToolText=TRUE
ToolNote=TRUE

Setting to TRUE causes DIDS to display all error messages
Setting to FALSE disables Rectangle button
Setting to FALSE disables Ellipse button
Setting to FALSE disables Polygon button
Setting to FALSE disables Magnify button
Setting to FALSE disables Free Hand button
Setting to FALSE disables Arrow button
Setting to FALSE disables Highlight button
Setting to FALSE disables Redact button
Setting to FALSE disables Text button
Setting to FALSE disables Note button
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ToolLogo=TRUE Setting to FALSE disables Logo button

[IDW_SETUP]
Version=01.00.03
NewSetup=FALSE
Interval=6
MaxInterval=50
ToolTop=42
ToolLeft=3
ToolBottom=98
ToolRight=1151
AnnotateTop=18
Annotateleft=842
AnnotateBottom=299
AnnotateRight=901
ScanWindowTop=102
ScanWindowLeft=897
ScanWindowBottom=802
ScanWindowRight=1148
ThumbnailQuality=1
ResizableChecks=0
ChildTop=60
ChildLeft=0
ChildBottom=806
ChildRight=712
WindowsNT=0

[IDW_SEARCH]
AnnotationFont=COURIER
AnnotationFontSize=75
XPosition=3

YPosition=8
DocumentName=NONE

[PUBLISH]

FTPServer=ftp.server.com

UserName=UserName

PassWord=PassWord

Folder=/images/
WebAddress=http://www.company.com/images/
Template=IDWsamp.tpl

ImageSize=1

ImageQuality=2
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